AquiStar® CT2X
Conductivity Smart Sensor
(With Pressure Option)
# Table of Contents

Introduction ..................................................................................................................... 3  
What is the CT2X with Pressure Option? ................................................................... 3 
Initial Inspection and Handling .................................................................................. 3 
Do’s and Don’ts .......................................................................................................... 3 
Connecting the Sensor to a Computer ...................................................................... 4 
Installing the Aqua4Plus Software ......................................................................... 4 
Using Aqua4Plus ........................................................................................................ 5 
Selecting a COM Port ............................................................................................... 5 
Selecting Units .......................................................................................................... 5 
Viewing the Sensor ................................................................................................... 6 
Setting Sensor Descriptions ..................................................................................... 6 
Selecting Linear or Non-Linear Mode ....................................................................... 6 
Calibrating ................................................................................................................ 7 
  Preparing for Calibration .......................................................................................... 7 
  Field Calibration — Conductivity ........................................................................... 8 
  Field Calibration — Temperature .......................................................................... 11 
  Field Calibration — Pressure ............................................................................... 12 
Taking Real Time Readings ...................................................................................... 13 
Recording Data ........................................................................................................ 14 
Retrieving Data ........................................................................................................ 15 
Viewing Data .......................................................................................................... 15 
Exporting Data ........................................................................................................ 17 
Importing Data Into a Spreadsheet .......................................................................... 17 
Maintenance ................................................................................................................... 18 
  Changing Batteries .................................................................................................. 18 
  Removing Debris from End Cone on Pressure Units ........................................... 19 
  Desiccant Tubes on Vented Pressure Units .............................................................. 19 
Miscellaneous ........................................................................................................... 20 
Appendix A: Grounding Issues ................................................................................... 21 
Appendix B: Technical Specifications ....................................................................... 22 
  Dimensions and Specifications ............................................................................... 22 
  Wiring Information .................................................................................................. 23 
Appendix C: Using USB to Serial Cables ................................................................... 24 
Appendix D: Version Information .............................................................................. 25 
  What You Should Know About Aqua4Plus and CT2X Versions ........................... 25 
  Other Considerations on a First Generation CT2X ............................................... 27 
Reordering Information ............................................................................................. 27 
Limited Warranty/Disclaimer - AquiStar® CT2X Conductivity Sensors .................... 28
VERSION NOTICE

Instrumentation Northwest has recently introduced a second generation CT2X. Second generation units will have a serial number higher than 2938001.

If you have a second generation version, you must use Aqua4Plus version 1.8.4 or later. If you use an earlier version, it will not be able to communicate with the CT2X.

If you have a first generation unit, please see Appendix D for important version differences.

Information in this document is subject to change without notice and does not represent a commitment on the part of the manufacturer. No part of this manual may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying and recording, for any purpose without the express written permission of the manufacturer.

©1997 - 2010 Instrumentation Northwest, Inc.
Registered trademarks and trademarks belong to their respective owners.
Introduction

What is the CT2X with Pressure Option?

The AquiStar® CT2X is a submersible conductivity/temperature sensor with built-in datalogging. This device stores thousands of records of conductivity, temperature, and time data. The CT2X is also available with a pressure option based on INW’s popular PT2X Smart Sensor, giving added functionality in the same sensor housing.

The CT2X incorporates 4-pole electrode cell measurement technology. This technology reduces fringe field interference errors, lessens inaccuracy caused by polarization effects, and lowers contact resistance problems. Four-pole electrode technology also allows users to work with one electrode over a wide range of conductivity.

The conductivity probe is constructed of epoxy/graphite, making it extremely durable for use in rugged field conditions. To clean, simply scrub with a small brush.

The CT2X is powered internally with 2 AA batteries or with an external auxiliary power supply for data intensive applications.

Most users will use the CT2X with INW’s Aqua4Plus software. However, the CT2X is quite versatile, communicating via either Modbus® or SDI-12 interfaces, allowing you to do the following:

- Read a CT2X via the Modbus® protocol using your own software.
- Read a CT2X via SDI-12 protocol.
- Display readings from a CT2X on a panel meter.

If you want to use one of these methods, please contact INW for further details.

Initial Inspection and Handling

Upon receipt of your smart sensor, inspect the shipping package for damage. If any damage is apparent, note the signs of damage on the appropriate shipping form. After opening the carton, look for concealed damage, such as a cut cable. If concealed damage is found, immediately file a claim with the carrier.

Do’s and Don’ts

Do handle the device with care.
Do store the device in a dry, inside area when not in use.
Do install a desiccant tube (pressure version only) if you are doing long-term outdoor monitoring with a gauge unit.
Do install the device so that the connector end is kept dry.

Don’t support the device with the connector.
Use a strain relief device to take the tension off the connectors.
Don’t allow the device to free-fall down a well as impact damage can occur.
Don’t bang or drop the device on hard objects.
Connecting the Sensor to a Computer

In its standard configuration, the Smart Sensor cable is terminated with a weather-resistant connector. Connect this to your PC or laptop serial port via the interface cable and an RS485/RS232 adapter, as shown below. If your computer does not have a serial port, you can connect to a USB port using a USB/Serial adapter. See Appendix C for details.

Installing the Aqua4Plus Software

1. Insert the Aqua4Plus CD in the CDROM drive on your PC or laptop. Installation should start automatically. If not, then follow steps 2 and 3. Otherwise, skip to step 4.
2. Click the Start button and select Run.
3. Type D:\setup.exe, where D: is the drive letter for your CDROM drive.
4. The Installation program will guide you through the installation process.

To start the Aqua4Plus software, use the Start Menu to navigate to the program group you selected during installation (typically this will be Aqua4Plus), and then click the Aqua4Plus icon.

Using the CT2X Without Aqua4Plus

Most users will use the CT2X with INW’s Aqua4Plus software. However, the CT2X is quite versatile, communicating via either Modbus® or SDI-12 interfaces, allowing you to do the following:

- Read a CT2X via the Modbus® protocol using your own software.
- Read a CT2X via SDI-12 protocol.
- Display readings from a CT2X on a panel meter.

If you want to use one of these methods, please contact INW for further details.
Using Aqua4Plus

Selecting a COM Port

Select the COM port to which your sensor is connected, by clicking on the down arrow on the tool bar, and then clicking on the COM port.

Selecting Units

Readings from the Smart Sensor can be displayed in various different units. To set the display units, open the Options Menu, and then select Display Units. Select the units by clicking on the down-arrows next to Pressure, Temperature, and Conductivity. For Pressure many options are available, including psi, Ft H2O, and mBars. For Temperature, select from degrees Celsius, Fahrenheit, or Kelvin. For Conductivity, select from micro-Siemens per centimeter (μS/cm) or milli-Siemens per centimeter (mS/cm) for conductivity, or milligrams per liter (mg/L) for total dissolved solids (TDS).
Viewing the Sensor

- Open the Sensor Window by clicking the tool button. The CT2X will appear on the Sensor Tree.
- On the Sensor Tree, click on the CT2X. Information regarding the selected sensor will display in the Sensor Information Panel to the right of the Sensor Tree.
- Click the + next to the desired sensor on the Sensor Tree. A list of data sessions stored in the sensor will display in the Sensor Tree below the selected sensor.

Setting Sensor Descriptions

Each sensor on the sensor tree can be assigned a short description. This description is displayed on the sensor tree and is recorded with collected data. To assign a description, click on the sensor on the sensor tree. Then select the Sensor Description option from the Configure menu.

Selecting Linear or Non-Linear Mode

All conductivity measurements are sensitive to temperature change. The CT2X has built-in temperature compensation to correct for changes in temperature. As a user, you can select either a linear temperature compensation method or a non-linear (nLFn) compensation method.

In the linear mode, a constant temperature coefficient is applied to the readings. This defaults to 2.1% per degree C, which works well for a wide range of applications. If you want to use the linear method with a different coefficient, then enter that coefficient in the Temp Coef box on the Field Calibration window.
Natural waters, such as ground water, streams, and rivers, often have a very low conductivity and do not respond to temperature in a linear fashion. For this situation, the CT2X provides a non-linear mode, which uses a complex formula to calculate and apply temperature compensation to the readings. This method meets the DIN EN 27888 standards. If you want to use the non-linear method, checkmark the Non-Linear box on the Field Calibration window. The temperature coefficient box will disappear.

**Temperature Coefficient for Linear Mode**

**Non-Linear Mode**

### Preparing for Calibration

- Click on the sensor on the sensor tree.
- Erase any sessions on the sensor. (Be sure to upload any data you want to save first.)
- Select the Field Calibration option from the Configure menu.
- Click on the channel you want to calibrate.
Field Calibration - Conductivity
To get the most accurate readings, you should calibrate the conductivity channel using a standard or reference close to the expected conductivity of your samples. If you will be using the nLFn mode for your measurements, you must use a standard that has a reference temperature of 25 degrees C.

NOTE: If you are using a first generation CT2X, see Appendix D for specific version information.

One-Point Calibration:
— Preparing —
• Select a standard that is close to the expected conductivity of your samples.
• Note the reference temperature on the standard’s packaging.
• Select that reference temperature on the calibration window.
• Make sure the Non-Linear box is not checked, unless using a Non-linear calibration standard.
• Enter the Temperature Coefficient (2.1 works for a wide variety of fluids). (Not needed if using a non-linear calibration standard.)
• If measuring TDS, enter TDS factor, if other than default of .49.

— Computing Calibration Value —
• Rinse sensor first with distilled water and then with a small amount of the standard.
• Dry with clean paper towel and cotton swab.
• Place sensor in standard.
• Make sure there are no bubbles around the conductivity element.
• Allow time for sensor to stabilize.
• In the Ref box for the first point, enter the reference conductivity, as specified on the bottle.
• Click first Measure button.
• When readings have stabilized to your satisfaction, click the OK button in the pop-up box.

— Applying Calibration Value —
• Click the Apply button to apply calibration value.
• The computed b value will be transferred to the calibration field.
• Click OK to save the value to the sensor.
Two-Point Calibration:
— Preparing —
• Select two standards that bracket the expected conductivity of your samples.
• Note the reference temperature on the standards’ packaging. (Must both be the same!)
• Select that reference temperature on the calibration window.
• Make sure the Non-Linear box is not checked, unless using non-linear calibration standards.
• Enter the Temperature Coefficient (2.1 works for a wide variety of fluids). (Not needed if using a non-linear calibration standard.)
• If measuring TDS, enter TDS factor, if other than default of .49.

— Compute First Calibration Point —
• Rinse sensor first with distilled water and then with a small amount of the lower standard.
• Dry with clean paper towel and cotton swab.
• Place sensor in lower standard.
• Make sure there are no bubbles around the conductivity element.
• Allow time for sensor to stabilize.
• In the Ref box for the first point, enter the reference conductivity, as specified on the bottle.
• Click first Measure button.
• When readings have stabilized to your satisfaction, click the OK button in the pop-up box.

— Compute Second Calibration Point —
• Rinse sensor first with distilled water and then with a small amount of the higher standard.
• Dry with clean paper towel and cotton swab.
• Place sensor in higher standard.
• Make sure there are no bubbles around the conductivity element.
• Allow time for sensor to stabilize.
• In the Ref box for the second point, enter the reference conductivity, as specified on the bottle.
• Click second Measure button.
• When readings have stabilized to your satisfaction, click the OK button in the pop-up box.
— Applying Calibration Values —

• Click the **Apply** button to apply calibration values.
• The computed m and b values will be transferred to the calibration fields.
• Click **OK** to save the values to the sensor.
Field Calibration — Temperature

The temperature channel on the CT2X rarely needs calibration in the field. If you do need to adjust its calibration, one- and two-point calibration can be performed from the Field calibration window as follows:

One- and Two-Point Calibrations
Temperature

One-Point Calibration:
— Computing Calibration Value —
• Place sensor in water. Allow time for sensor to reach thermal equilibrium.
• Using an accurate alternate measuring device, measure the temperature of the water.
• In the \textit{Ref deg} box for the first point, enter this temperature.
• Click first \textit{Measure} button.
• When readings have stabilized to your satisfaction, click the \textit{OK} button in the pop-up box.

— Applying Calibration Value —
• Click the \textit{Apply} button to apply calibration value.
• The computed b value will be transferred to the calibration field.
• Click \textit{OK} to save the value to the sensor.

Two-Point Calibration:
— First Calibration Point —
• Place sensor in water at first temperature. Allow time for sensor to reach thermal equilibrium.
• Using an accurate alternate measuring device, measure the temperature of the water.
• In the \textit{Ref deg} box for the first point, enter this temperature.
• Click first \textit{Measure} button.
• When readings have stabilized to your satisfaction, click the \textit{OK} button in the pop-up box.

— Second Calibration Point —
• Place sensor in water at second temperature. Allow time for sensor to reach thermal equilibrium.
• Using an accurate alternate measuring device, measure the temperature of the water.
• In the \textit{Ref deg} box for the second point, enter this temperature.
• Click second \textit{Measure} button.
• When readings have stabilized to your satisfaction, click the \textit{OK} button in the pop-up box.
Field Calibration — Pressure
Before shipping, the pressure channel has been calibrated using sophisticated environmental chambers and deadweight testers. As the sensor can drift slightly over time, it may occasionally need field calibration. If the pressure needs to be calibrated, one- and two-point calibration can be performed from the Field Calibration window as follows:

**One- and Two-Point Calibrations**

**Pressure**

**One-Point Calibration:**

— Computing Calibration Value —

- Place sensor in the fluid you are measuring at a precise known level.
- In the Ref box for the first point, enter this level or pressure.
- Click first Measure button.
- When readings have stabilized to your satisfaction, click the OK button in the pop-up box.

— Applying Calibration Value —

- Click the Apply button to apply calibration value.
- The computed \( b \) value will be transferred to the calibration field.
- Click OK to save the value to the sensor.

**Two-Point Calibration:**

— Compute First Calibration Point —

- Place sensor in the fluid you are measuring at a precise known level.
- In the Ref box for the first point, enter this level or pressure.
- Click first Measure button.
- When readings have stabilized to your satisfaction, click the OK button in the pop-up box.

— Compute Second Calibration Point —

- Place sensor in the fluid you are measuring at a second precise known level.
- In the Ref box for the second point, enter this level or pressure.
- Click second Measure button.
- When readings have stabilized to your satisfaction, click the OK button in the pop-up box.
— Applying Calibration Values —

• Click the **Apply** button to apply calibration values.
• The computed m and b values will be transferred to the calibration fields.
• Click **OK** to save the values to the sensor.

---

**Taking Real Time Readings**

Use the Real Time Monitor (lower part of Sensor Window) to view live readings from the sensor that is selected on the Sensor Map. These readings are not being recorded in the sensor, but only displayed for real time viewing. The Real Time Monitor can be used whether or not the sensor is actively recording a session.

To obtain and display a single reading, click the **Single** button.

To obtain and display readings continuously for 60 readings, click the **Start** button.

To stop the monitor, click the **Stop** button.

---

![Real Time Monitor on Sensor Window](image)
Before you can collect data in the logger, you must create a Session Profile, which describes the type and duration of records to record.

Create recording sessions as follows:

- **Select the sensor** you want to program from the Sensor Tree.
- **Start a new session**: Click the tool button. A Session Profile Window will open. (See illustration on next page.)
- **Name your session**: Enter a name in the Session ID box, or leave as is to accept the default name.
- **Describe a test phase**:
  - Click the number at the beginning of the test phase.
  - Use the Tab key on the keyboard to move to the sample interval column, and enter your sample interval for this phase as dd/hh:mm:ss.
  - Enter the number of samples to record at this sampling interval, then press the Tab key. You will automatically move to the next phase’s sampling interval field.
  - Continue entering phases as above.
- If you will be correlating the data from both sensors, you may want to use the Delayed Start in order to assure your sessions start at the same time.
  - Click the Delayed Start checkbox.
  - Enter the date and time you want the test to start. (Time is in 24 hour format.)
- **Start the test**: Click the Start button. Your session will appear on the sensor tree with a green light in front of the session name. (If you have selected a delayed start, your session will appear with a clock face in front of the session name.)

For more detailed information on creating sessions, refer to the *Aqua4Plus Control Software Instruction Manual.*
Retrieving Data

- On the Sensor Tree, click on the session you want to upload.
- Click the tool button.
- Select a file location and enter a name for the file.
- Click Save.
- Click Start.

Viewing Data

- Click the tool button to view data as a table.
- Click the tool button to view data as a graph.
- Navigate to the desired file, then click the Open button. (If the File Open box does not appear, click the File Menu, then select Open.)
(See illustrations of table and graph formats on next page.)
### File Display Window

![File Display Window](image)

### Graph Window

![Graph Window](image)
Exporting Data

- Using the File Display window, open the file you want to export.
- Click on the tool button.
- Select a file location and enter a name for the file or leave as is to accept the current file name.
- Select a file type. Files can be saved in either Text (.csv) or Excel (.xls) formats. Select the file type from the drop-down Save-as-type box. (.xls formatted files can be opened in Excel. .csv formatted files can be opened in Excel and most other popular spreadsheets, databases, and word processors.)
- Click Save. You will be given the option of viewing it in Excel. You must have Excel installed on your machine in order to make use of this option. (Note: if you have Office 2007 or later, you may need to open the exported file directly from Excel - not Aqua4Plus).

Importing Data Into a Spreadsheet

To import data to a spreadsheet or database, you must first Upload and Export the data to a .csv file. (See previous sections on uploading and exporting.) Most spreadsheets and databases can readily import .csv files. Microsoft® Excel can import either .csv or .xls files. Following are instructions for importing a data file into Excel. For importing into other programs, see documentation with the particular program.

1. Open Excel.
2. Click on the File menu, and then select Open.
3. On the Open dialog box, click the down-arrow to the right of the Files of Type field. (This is the last field on the dialog box.)
4. Click the option All Files.
5. Navigate to the saved file, and then click the Open button in the lower right corner of the dialog box.

The data will be opened in Excel. (Note: While Aqua4Plus can handle over 130,000 records, Excel is limited to approximately 65,000 records.)
Maintenance

Changing Batteries

Because changing the batteries involves opening the water-tight seal, this must be done in a clean, dry environment to avoid contamination or moisture damage to the circuitry.

The CT2X uses two standard AA Alkaline batteries.

Opening the Housing

Open the housing by removing the top-cap, as outlined below. The top-cap is the connector between the tube housing the sensor and the cable.

1. Twisting gently, unscrew the top-cap.

2. Gently separate the top-cap from the body of the sensor. Top-cap remains attached to body via several colored wires.

Caution! Pulling forcefully on the top-cap can pull the insides out of the sensor or snap the connections inside. Removing the circuit board or pushing on the surface of the pressure element may void your warranty.

Note: O-rings provide a water-tight seal for the sensor housing. Take care not to nick or otherwise damage these O-rings.

Gently remove the top cap and slide batteries out.
Replacing Batteries

3. Tip housing over and gently slide batteries out.
4. Insert new batteries - **positive terminals towards the top-cap**.
5. Replace and retighten top-cap.

Removing Debris from End Cone on Pressure Units

At times mud, silt, or other debris may foul the water inlets to the pressure element. The end cone can be removed to clean out the debris.

1. Gently twist off end cone portion only - do not twist off pressure element!
2. Remove debris. **Take care not to poke anything into the sensor.** This can damage the sensor element and void the warranty.
3. Replace and retighten the end cone.

Desiccant Tubes on Vented Pressure Units

On vented pressure sensors, inspect the desiccant tube at least once every two months. The desiccant tube prevents moisture in the air from being sucked into the vent tube, which can cause erratic readings and sensor damage.

The desiccant tube is filled with blue silica gel beads. A locking barb and a hydrophobic water filter are attached to the end of the desiccant tube. This filter prolongs the life of the desiccant as much as three times over a desiccant tube without the filter. This filter also prevents water intrusion should the desiccant tube be submerged under one to two feet of water.

If at all possible, install the sensor so that the desiccant tube will not flood or lie in water. (Note: Though the hydrophobic filter will prevent water intrusion via the desiccant tube, care must still be taken to keep the cable connector from being submerged.)
The desiccant is a bright blue color when active and dry. As moisture is absorbed the color will begin to fade, becoming a light pink, which indicates full saturation and time to replace. Replacement desiccant and hydrophobic filters can be purchased from INW; please contact an INW sales engineer at 1-800-776-9355 for more information.

The desiccant tube prevents water intrusion through the vent tube. Be sure to replace the desiccant when it turns pink, as that indicates it is saturated.

---

**Miscellaneous**

**Sensor:** There are no user-serviceable parts, other than the batteries.

**Cable:** Cable can be damaged by abrasion, sharp objects, twisting, crimping, crushing, or pulling. Take care during installation and use to avoid cable damage. If a section of cable is damaged, it is recommended that you send your sensor back to replace the cable harness assembly.

**End Connections:** The contact areas (pins & sockets) of the connectors will wear out with extensive use. If your application requires repeated connections other types of connectors can be provided. The connectors used by INW are not submersible, but are designed to be splash-resistant.
Appendix A: Grounding Issues

It is commonly known that when using electronic equipment, both personnel and equipment need to be protected from high power spikes that may be caused by lightning, power line surges, or faulty equipment. Without a proper grounding system, a power spike will find the path of least resistance to earth ground – whether that path is through sensitive electronic equipment or the person operating the equipment. In order to ensure safety and prevent equipment damage, a grounding system must be used to provide a low resistance path to ground.

When using several pieces of interconnected equipment, each of which may have its own ground, problems with noise, signal interference, and erroneous readings may be noted. This is caused by a condition known as a Ground Loop. Because of natural resistance in the earth between the grounding points, current can flow between the points, creating an unexpected voltage difference and resulting erroneous readings.

The single most important step in minimizing a ground loop is to tie all equipment (sensors, dataloggers, external power sources and any other associated equipment) to a single common grounding point. INW recommends connecting the shield to ground at the connector end.
### Appendix B: Technical Specifications

#### Dimensions and Specifications

**MECHANICAL**

<table>
<thead>
<tr>
<th>Description</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SENSOR</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Body Material</strong></td>
<td>316 stainless</td>
</tr>
<tr>
<td>(Titanium option)</td>
<td></td>
</tr>
<tr>
<td><strong>Probe Material</strong></td>
<td>Epoxy/Graphite</td>
</tr>
<tr>
<td><strong>Electrode</strong></td>
<td>4-pole</td>
</tr>
<tr>
<td><strong>Wire Seal Materials</strong></td>
<td>Viton® and Teflon®</td>
</tr>
<tr>
<td><strong>Desiccant</strong></td>
<td>High- &amp; Standard-capacity packs</td>
</tr>
<tr>
<td><strong>Terminating Connector</strong></td>
<td>Available</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>Less than 1 pound</td>
</tr>
<tr>
<td><strong>Length</strong></td>
<td>16.565&quot; (with pressure option)</td>
</tr>
<tr>
<td>(without pressure option)</td>
<td>14.546&quot;</td>
</tr>
<tr>
<td><strong>Diameter</strong></td>
<td>0.75&quot;</td>
</tr>
</tbody>
</table>

**CABLE**

<table>
<thead>
<tr>
<th>Description</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>OD</strong></td>
<td>0.28&quot; maximum</td>
</tr>
<tr>
<td><strong>Break Strength</strong></td>
<td>138 lbs</td>
</tr>
<tr>
<td><strong>Maximum Length</strong></td>
<td>2000 feet</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>4 lbs. per 100 feet</td>
</tr>
</tbody>
</table>

**ELECTRICAL**

**CONDUCTIVITY**

<table>
<thead>
<tr>
<th>Description</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Static Accuracy</strong></td>
<td>± 0.5% of measured value</td>
</tr>
<tr>
<td><strong>Range - Conductivity</strong></td>
<td>10 - 100,000 microSiemens/cm</td>
</tr>
<tr>
<td><strong>- TDS</strong></td>
<td>4.9 - 49,000 mg/L</td>
</tr>
<tr>
<td>(with default TDS factor of .49)</td>
<td></td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
<td>0.1 for microSiemens/cm</td>
</tr>
<tr>
<td></td>
<td>0.001 for milliSiemens/cm</td>
</tr>
<tr>
<td></td>
<td>0.1 for mg/L (TDS)</td>
</tr>
<tr>
<td><strong>Over Range Protection</strong></td>
<td>2x (except 300 PSI and higher)</td>
</tr>
<tr>
<td><strong>Operating Temp. Range</strong></td>
<td>0° C to 80° C</td>
</tr>
</tbody>
</table>

**PRESSURE**

<table>
<thead>
<tr>
<th>Description</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Static Accuracy</strong></td>
<td>± 0.1% FSO (maximum)</td>
</tr>
<tr>
<td>(B.F.S.L. 25° C)</td>
<td>± 0.06% FSO (typical)</td>
</tr>
<tr>
<td><strong>Maximum Zero Offset</strong></td>
<td>± 0.25% FSO</td>
</tr>
<tr>
<td>at 25° C</td>
<td></td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
<td>16 bit</td>
</tr>
<tr>
<td><strong>Over Range Protection</strong></td>
<td>2x (except 300 PSI and higher)</td>
</tr>
<tr>
<td><strong>Compensated Temp. Range</strong></td>
<td>0° C to 40° C</td>
</tr>
</tbody>
</table>

**TEMPERATURE**

<table>
<thead>
<tr>
<th>Description</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Accuracy</strong></td>
<td>± 0.5° C</td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
<td>0.1° C</td>
</tr>
</tbody>
</table>
Wiring Information

For Modbus® with firmware lower than 2.0 — with 5-pin connector

- 12 VDC+ (Vaux)
- Modbus D-
- Modbus D+
- Digital I/O (Not used)
- Ground

For Modbus® with firmware 2.0 or higher — with 5-pin connector

- 12 VDC+ (Vaux)
- Modbus D-
- Modbus D+
- SDI-12 (Not used)
- Ground

For SDI-12 with firmware 2.0 or higher — with 5-pin connector

- 12 VDC+ (Vaux)
- Modbus D- (Not used)
- Modbus D+ (Not used)
- SDI-12 Signal
- 12 VDC – (Gnd)

For SDI-12 with firmware 2.0 or higher — without connector

- 12 VDC+ (Vaux)
- Modbus D- (Not used)
- Modbus D+ (Not used)
- SDI-12 Signal
- 12 VDC – (Gnd)
- Earth ground
Appendix C: Using USB to Serial Cables

The standard communication cable/RS485-232 adapter that comes with the Smart Sensor plugs into a 9-pin serial port on the PC or laptop. Many new computers, especially laptops, do not come with 9-pin serial ports. If you have one of these computers, or if all of your serial ports are in use, you can connect to a Smart Sensor using a USB to Serial adapter, as shown below.

USB-to-Serial cables are readily available from many electronics and computer stores, as well as numerous sites on the Internet. INW has tested and recommends the Keyspan USA-19HS. It is available from INW or from the Internet.

Install as follows:

- **Plug into USB port**
- **Install the drivers provided with the particular unit.** (If using Windows® Vista or Windows® 7, you will need to download the Vista drivers from Keyspan’s web site at www.tripplite.com/en/support/downloads.)
- **Determine the port number to which the adapter assigned**
  - Right-click on My Computer
  - From the popup menu, select Manage to open the Computer Management window
  - On left panel, click on Device Manager
  - On right panel, double-click on Ports
  - A list of active COM ports will be displayed. Note the COM number assigned to the adapter you just installed.

  *For example:* Keyspan USB Serial Port (COM8)
  - Close Manager.
- **Connect to the Smart Sensor**
- **On the Aqua4Plus software, select the COM port.** (Note: if you do not see your new COM port in the drop-down box, open the Communications dialog box from the Options menu. Increase the Highest COM port number.)
Appendix D: Version Information

What You Should Know About Aqua4Plus and CT2X Versions

Instrumentation Northwest has recently introduced a second generation CT2X. Second generation units will have a serial number higher than 2938001.

If you have a first generation unit, please read this section carefully. If you are using a second generation unit, you can disregard this section.

Our first generation CT2X Conductivity Smart Sensors originally had a one-point field calibration for the conductivity channel. To meet customer requests, we later updated the CT2X to support a two-point field calibration. This Appendix explains how to tell which version you have and what ramifications that has on the software you use.

Which version of first generation CT2X do I have?

The earlier CT2X sensors have version 0.3 firmware. The updated versions have 0.4 or higher firmware. Determine your firmware version as follows:
• Run Aqua4Plus with your CT2X attached.
• Scan for sensors, and then click on your CT2X.
• Click on the button on the right panel.
• The firmware version will display in the drop-down panel.

Firmware Version
What effect does this have on the software I am using?

The effect will depend on what version of Aqua4Plus control software you are using. You can determine the version by running Aqua4Plus, clicking on the Help menu, and then selecting About. The version number will display on the About window.

What if I have firmware version 0.3?

This version of firmware only supports one-point calibration. CT2X sensors with version 0.3 firmware will work fine with all versions of Aqua4Plus since 1.6.8 (1.6.8, 1.6.10, 1.7.0, 1.8.0, 1.8.3, and 1.8.4, etc.). If you want to do a field calibration follow the instructions on the field calibration window.

What if I have firmware version 0.4 or higher?

This version of firmware supports two-point calibration, but only on some versions of Aqua4Plus. If you have been using your sensor with Aqua4Plus version 1.7.0 or earlier, you can continue to do so, but only the one-point calibration will be supported.

What if I have or want to upgrade to Aqua4Plus version 1.8.0 or later?

The different Aqua4Plus versions store the values generated during field calibration in different places, both on the sensor and in the data file. Because of that, if you are upgrading from an earlier Aqua4Plus version to version 1.8.0 or later, you will need to recalibrate your CT2X sensors with the new version, before collecting data. (Calibration instructions are on the Field Calibration window.)

All new data files should be read with the new Aqua4Plus. Also, any data you have collected using older versions of Aqua4Plus, must be read with version 1.7.0 or earlier. For this reason, you may want to keep copies of both versions installed on your computer.

What happens if I read old files with the new software or new files with the old software?

Because the programs expect calibration values to be stored in different places, unknown values may be used during math operations on the data, thus resulting in incorrect final data.

What if I want to upgrade to the version 0.4 or higher from my current 0.3 version?

Upgrading the firmware is accomplished via a firmware download operation. You do not need to send the sensor back to the factory. If you would like to upgrade, contact your INW sales representative, who will be glad to see that you get the correct firmware version, software version, and instructions for upgrading.
Other Considerations on a First Generation CT2X

For a first generation CT2X with pressure option, you will see two sensors listed on the tree--a CT2X and a PT2X. The CT2X measures conductivity. The PT2X measures pressure. Aqua4Plus treats the CT2X and the PT2X as separate sensors--they each have their own temperature channel; they each have their own clock; and each is read separately.

On the Sensor Tree, click on either the CT2X or the PT2X. Information regarding the selected sensor will display in the Sensor Information Panel to the right of the Sensor Tree.

Setting Sensor Clocks

Each sensor has its own internal clock. Set this clock by clicking on the sensor, and then selecting the Sensor Clock option from the Configure menu. A pop-up box displays the date/time currently in the sensor. Click the Set From System Clock button to set the sensor clock to match that of your host computer. Alternately, type in a specific date/time and click the Set Clock button. INW highly suggests that you set both the CT2X and the PT2X clock using Set from System Clock. This will assure that both sensors are set to the same time.

Recording Data

The CT2X and the PT2X portions must be programmed separately. (If you will be correlating the data from both sensors, then before starting a recording session, set the clocks in both the CT2X and the PT2X to the same time as shown in the section above.

Reordering Information

For sales & service offices, please contact:

Instrumentation Northwest, Inc.
www.inwusa.com
800-776-9355
LIMITED WARRANTY/DISCLAIMER - AquiStar® CT2X
CONDUCTIVITY SENSORS

A. Seller warrants that products manufactured by Seller when properly installed, used and maintained with a properly installed desiccant tube, shall be free from defects in material and workmanship. Seller’s obligation under this warranty shall be limited to replacing or repairing the part or parts or, at Seller’s option, the products which prove defective in material or workmanship within ONE (1) year from the date of delivery, provided that Buyer gives Seller prompt notice of any defect or failure and satisfactory proof thereof. Any defective part or parts must be returned to Seller’s factory or to an authorized service center for inspection. Buyer will prepay all freight charges to return any products to Seller’s factory, or any other repair facility designated by Seller. Seller will deliver replacements for defective products to Buyer (ground freight prepaid) to the destination provided in the original order. Products returned to Seller for which Seller provides replacement under this warranty shall become the property of Seller.

This limited warranty does not apply to lack of performance caused by abrasive materials, corrosion due to aggressive fluids, mishandling or misapplication. Seller’s obligations under this warranty shall not apply to any product which (a) is normally consumed in operation, or (b) has a normal life inherently shorter than the warranty period stated herein.

In the event that equipment is altered or repaired by the Buyer without prior written approval by the Seller, all warranties are void. Equipment and accessories not manufactured by the Seller are warranted only to the extent of and by the original manufacturer’s warranty.

THE FOREGOING WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES, WHETHER ORAL, WRITTEN, EXPRESSED, IMPLIED OR STATUTORY. IMPLIED WARRANTIES OF FITNESS AND MERCHANTABILITY SHALL NOT APPLY. SELLER’S WARRANTY OBLIGATIONS AND BUYER’S REMEDIES THEREUNDER (EXCEPT AS TO TITLE) ARE SOLELY AND EXCLUSIVELY AS STATED HEREIN. IN NO CASE WILL SELLER BE LIABLE FOR CONSEQUENTIAL DAMAGES, LABOR PERFORMED IN CONNECTION WITH REMOVAL AND REPLACEMENT OF THE SENSOR SYSTEM, LOSS OF PRODUCTION OR ANY OTHER LOSS INCURRED BECAUSE OF INTERRUPTION OF SERVICE. A NEW WARRANTY PERIOD SHALL NOT BE ESTABLISHED FOR REPAIRED OR REPLACED MATERIAL, PRODUCTS OR SUPPLIES. SUCH ITEMS SHALL REMAIN UNDER WARRANTY ONLY FOR THE REMAINDER OF THE WARRANTY PERIOD ON THE ORIGINAL MATERIALS, PRODUCTS OR SUPPLIES.

B. With respect to products purchased by consumers in the United States for personal use, the implied warranties including but not limited to the warranties of merchantability and fitness for a particular purpose, are limited to twelve (12) months from the date of delivery.

Some states do not allow limitations on the duration of an implied warranty, so the above limitation may not apply to you. Similarly, some states do not allow the exclusion or limitation of consequential damages, so the above limitation or exclusion may not apply to you. This limited warranty gives you specific legal rights; however, you may also have other rights which may vary from state to state.